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Introduction

Video formats available for the application and notes

@ Video formats available in the instax Biz™ app

Transparent video specification that can be imported into the application

file format mov(iOS) / webm(Android)

file size 100 MB or less

instax™ mini: 600x800 pixel
Image aspect size instax™ SQUARE: 800x800 pixel
instax™ WIDE: 1260x840 pixel

Video Length 3-10 sec.

frame rate 60 fps or less

@ Points to note when using the video template function

e Stillimages, QR codes and dates cannot be added when a video template is used in the app.

at tt(;r:F:;rant: of e Preview playback of the video template is possible, but editing such as layout adjustment is not possible.
creation e Video templates can only be shared between devices running the same operating system;

sharing between iOS and Android devices is not possible.

at the time of > e No other operations are possible during playback of the movie template (equivalent to using the self-timer).

ShOOtlng *Random shooting, camera/flash/timer switching, color correction (auto/manual), and print history are available.




Media Video Shooting (Green Background Shooting)




Media Video Shooting (Green Background Shooting)

Shooting Environment

3,500

LED blackout

Lighting curtain
(600W)
H2,000 2,000
2,550
800
Photography
Equipment

Lighting for models |___

The figures are evenly lit,
Avoid casting shadows on
the green background \

iPad-Camera

The background of the subject
should not extend beyond the
green background.

Distance - angle of view

Example of

4
L
"

1

| immy
i

photographer's shout

If no audio recording
Communicate timing by counting up.
One, two, three, four, five (walk out)

----- 15, cut!

For voice recording

Count up with your hands to tell the timing.

Recommended playback time is 5
seconds. The second half should be
longer than the first half to allow
people to arrange themselves for the
photo.

Lighting for greenbacks

Uniform illumination of the green backdrop
is desirable.

(Unevenness will not allow for good
transparency processing.)

< |
)|
attire

Z Do not wear bIaCk_OUt
clothing or curtain
objects that are Putup a
in the same hue blackout
range as the curtain so
greenback. that the

model is not
affected.

position
(where
someone is
standing)
Mark the model's
standing position.

Key points
regarding
greenbacks

If the model's costume or

uniform is greenish or
green is used

change blueback, etc.




Media Video Shooting (Green Background Shooting)

Equipment Settings and Angle of View

1. When the setting of the photographic equipment is 2. Shoot with the widest possible angle of view to
set to high image quality mode, reduce image make it easier to adjust the crop when editing.
quality degradation due to trimming during editing.

For iPhone, iPad: Settings > Video Recording > 4K/30 fps, and also turn on

"Lock White Balance". {5
Settings < Camera Recard Video mini size SQUARE size
@ General 720p HD at 30 fps
Accessibility 1080p HD at 30 fps
) Apple Intelligence & Siri 1080p HD at 60 fps
2 ~ople Pencil 4K at 24 fps
B Camera 4K at 30 fps i
e i R The screen will be cramped and

the space for customers to enter

Display & Brightness .
e will be small.

Home Screen & App Library

Multitasking & Gestures

EY searcn Show PAL Formats
Wallpaper L 1 & TAiaion VHaas TorTmar Vst Ty ey CoUn e L Edromo Aics
Asla, and South Amarica
mini size SQUARE size
0 Notifications Auto FPS Auto 30 fps
€D sounas
Foeus Video Format Contral
B Screen Time
Lock Camera
B Face ID & Passcode
Pri it N
O privacy & secuiy , Poses are easier to understand and
Fock white Baiance © easier to trim.
& G i
& iCloud

B wallet & Apple Pay

. Apps



Video template creation

Video Editing Environment

@ Adobe® Premiere® Pro (Windows/Mac)
. MacOS * Required for HEVC Video with Alpha output

*Adobe® product screenshot(s) reprinted with permission from Adobe®.



1. Load the video shot from "New Project" into Adobe® Premiere® Pro and press the "Import Button".

& Import Edit Expaort template

AVORITES » . s , Import setti
Biz BT~ 7L — | — SQUARE template % mport settings

% Footage ( :oa= — B T e Organize Media
New Project * Sample Media

Copy media

Open Project NAME =1 DURATION FRAME 5IZE FRAME RATE
LOCAL Create new sequence
Nishio with vaice e
=04 FI5-07-30 091600 354 -0 (10 me
P A Home i 00:00:16:04 2025-02-20 09:16:00 38402160 (1.0)
s Sequence 01

[:l Desktop Nichio without voice

D0:00:13:18 2025-02-20 09:16:00 3B40x2160 (1.0)

%" Learn %
H Documents * Automatic transcription

Language
Downloads i

Movies

O Enable language auto-detection
Music

- Fictures Speaker labeling

Sample Media

Transcription preferences

DEVICES

B Macintosh HD

woup

& iCloud

New Team Project

Open Team Project

Open Premiere Rush Project




2. Right-click on the shooting data in the "Project" area and open "Sequence Settings".

template - Edit

Cut
Copy

Clear

Duplicate

Hide
View Hidden

Moedify
Media File Propertie

Rename

Auto Reframgf Sequence...

ake Offline...

" Nichia without volce MOV [\




3. Specify "Time Base," "Frame Size," "Preview File Format," and "Codec" in the "Sequence Settings" dialog box.

Sequence Settings

General

Set frame rate

Resolution (template size).
For mini film 600x800pixels
for SQUARE film 800x800pixels
for WIDE film 1260x840pixels

Preview codecs with
alpha channel
(ProRes 4444).

Apple ProRes 4444




4. Double-click Preview in the main area (Program Panel) and adjust the angle of view-composition so that the
green background and subject position match the instax Biz™ template size specified earlier.

template - Edited

Program: Sequence 01

Double-click to display the
adjustment frame (blue
frame) with the blue frame
appearing.

Move the preview to adjust
position.

a4 > > 4 vt @ Wy %




1. Cut and edit the video for the instax Biz™ template so that the playback time of the clip is 3-10 seconds (5 seconds is recommended).

2. The final frame of the clip should be the final composition of the photo taken with the instax Biz"™ . (Always compose with the subject in
the picture)

1



1. Select a clip from the timeline and choose "Unlink" from the contextual menu (right-click).

2. The link between the video and audio of the clip will be broken, so delete only the audio portion of the clip
using the Delete key, etc.

Cut
Copy

Remove Attributes...
Clear
Ripple Delete

Edit Original

Render and Replace...

1 Nest...
After unlinking, = Make Subsequence
audio is deleted LF .

Speed/Duration...

Scene Edit Detection...

Ignore Transcript

Audio Channels...
Auto-Tag Audio Types
Nichio without voloe MOV [V] A Enable Enhance Speech
'

Frame Heold Options...
Add Frame Hold

Fit to frame




1. From the project panel (lower left area of the screen), select the "Effects" tab, and from "Video Effects", select
"Keying" -> "Ultra Key".

2. Drag and drop the "Ultra Key" item onto the video clip in the timeline.

Default hd

Y

Media Browser

00:00:15:00

Effect (fx) mark
lights up

13



3. Select a video clip from the Timeline, then select "Effects Control" in the Source panel
(upper left area of the screen).

4. Open the "Ultra Key" menu under "Effects Controls" and the "Matte Generation" submenu below it.

Import Edit  Export template - Edited
Effect Contn = Program: Sequence 01 =

#= SequenceOl... , | o

"Nichio

5

D155

=
=y
[ =
L
=

14



5. Select the "Ultra Key" eyedropper

tool at, then select the Program
panel (upper right corner of the
screen).Select a point on the green
background (area) to display the
points where the green background
disappears, and find the point
where the entire green background
disappears,Repeat the "eyedropper
tool" point selection.

. From the "Matte Generation"
submenu Open the "Highlights" and
"Pedestals" menus so that the
green areas of the green
background are filled with uniform
black.Adjust the highlight and
pedestal values, respectively.

If you save the project at this point,
you will see the black areas in
Adobe® Premiere® Pro.

It is stored as an alpha mask.

After that, the alpha channel is
retained,Export the video and you
are done.

3

Import Edit  Export

template - Edited

Effect Controls = Program: Sequence 01 =

S Sequence01-.. |

Green background disappears
(partially) when green area is selected
with the "eyedropper tool

*The entire image is selected by selecting the area
with the highest saturation-lightness as possible.

Fine-tune highlights and pedestals to eliminate uneven disappearance.

(Check the timeline as you move it)

15



1. Select the "Export" tab in
Adobe® Premiere® Pro and
save to Media File."
black areas in
Adobe® Premiere® Pro.

It is stored as an alpha mask.

Media File i
PUSLISH

2. Specify the destination in
"File Name" and "Location"
and click "Save" to save the
file, Preset" to "Custom."
Format" as "QuickTime",
Video Codec." Set to "Apple
ProRes 4444".

3. From the "Basic Video"
settings enable "Audio" and
"Video" and disable
"Captions", "Effects" and
"Metadata".

Baslc Video Settings

template - Edited

Preview

Audio: 44100 Hz | Stereo

00:00:05:0

i)

o]

16



4. The settings for "Video" shall be as follows

video codec Apple ProRes 4444
Basic Video Settings | adapt to the source
Export color space Rec. 709.

number of bits 16 bpc + alpha

5. Change the "Scope" to "Entire Source" or E
Source in/out", Click the "Export" button.

Advanced Settings

Background transparency,

Apple ProRes 4444 (QuickTime .mov)
video files.

CAPTIONS

EFFECTS

Data conversion fori0S [ AL} —

GENERAL

Data Conversion for Android [ gl k)

Apple ProRes 4444 cannot be played on Windows Media Player or VLC Player, but can be played using Adobe® Premiere® Pro / After Effects® or DaVinci Resolve.

17



Saving video in HEVC Video with alpha (using MacOS functionality)

1. Copy the Apple ProRes 4444 format video (.mov) files exported by Adobe® Premiere® Pro to a MacOS machine.

2. Select a video (.mov) file in Apple ProRes 4444 format in the MacOS Finder and choose "Encode Selected
Video File" from the context menu (right click).

3. In the "Encode Media" dialog, set "Settings :" to "HEVC 1080p" and "Keep Transparency" and press the
"Continue" button.

4. Encoding begins and a file with subscripts to the original filename (this will be the HEVC file) is generated.

® Encode Media

nen Setting: HEVC 1080p B [ Preserve Trensparency

| Open With > Format: HEVC/AAC

Reselution: up to 1920x1080
Move to Trash Destination: Same as sourccliteel ([T

Get Info

Rename

Compress "Sequence 01.mov"
Duplicate

Make Alias

Quick Look

Copy
Share...

® O N N N
Tags...

Quick Actions >

BRLEETAZPAILETI>O—R The same operation as executing the following command from the MacOS console
$ avconvert --preset PresetHEVC1920x1080WithAlpha -s . /tmp.mov -o . /output.m4v

18



Data Conversion for Android

1. WebM files can be exported using FFmpeg from Apple ProRes 4444 format video (.mov) files exported by
Adobe® Premiere® Pro.

2. Execute the following command to export the WebM file.

$ ffmpeg -i ( input file <ProRes 4444 or other transparent video >) ( filename ).webm

Other options available in FFmpeg
-r (N) : Specify frame rate
-plays (N): Specifies the number of plays
-f (format): Specify the format to convert to

If the input file contains an alpha channel, the output will also have an alpha channel.

WebM files can be loaded into web browsers such as Chrome and Firefox for playback.

19
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Procedure for overlaying a template (design frame for a still image)

1. Load template data into the project panel (lower left area of the screen).
2. Drag and drop the template file onto "Video 1" in the sequence panel.

template - Edited

Program: Sequence 01

= Sequance0l- L [ Loaesinom

« SQUARE_MIN
P

Template data > =

)

MINERVA AFC

© o T AT

SQUARE_MINERVA.png

21



Color blur remains at the border between the person and the background

Create a new layer below the layer of the subject image and fill it with a complementary color (such as purple or

red) or black, where color coverage is noticeable, so that it is easy to see if there is color coverage at the border
between the person and the background.

1. From the "Filter" menu Select the Camera Raw filter. . 3. From the "Selection" menu, select "Color

2. From the "Color" submenu, adjust the "Color Blur Range...", Select the color coverage with the
Correction" slider to the right (toward purple) and press eyedropper tool, Adjust the "Tolerance"
the "OK" button. ’

_ slider so that the color-covered area is
If the color coverage can now be corrected, save the image.

(If there are no problems with the shooting conditions, the color selected.
blurring at the boundary can be removed at this point.) If the color :

blurring cannot be removed, continue with the procedure in Section 3.4. With the "eyedropper tool" The selected green

Click on the green area Adjust color range with slider

Camera Raw Filters

When the selec-
tion is confirmed,
green use the Delete
cover : _ _ L | key to delete
with L (make transpar-

. : S N ent) the selection
slider R s SR at the boundary.

Adjust

22



© After Effects® (Windows/Mac)

Timer animation gif Video ConverSion ® Used to convert timer images for instax Biz"app

1. Load the animation gif file into After Effects®. The HEVC file is generated.
2. Drag the loaded animation gif file to the timeline (lower right area).

3. Edit the video on the timeline to the length of time you want to output.

I4 4 > [

Properties: o Selection When using the “In-camera
Mirror Mode” with the instax
BizZTM app, the video template
will be played in a mirrored
state. When using the
“In-camera Mirror Mode”, we
recommend that you either do
not use the timer animation,
or that you use a mirrored
timer animation. If you do not
use the timer animation, you
can add audio or use the
app's “Settings” >

“Video shooting timer settings”
to notify the user of the
shutter timing.

=)




Timer animation gif video conversion

4. Select "Add to Render Queue" from the "Composition" menu.

ffects File Edit Composition Layer Effect Animation View Window Help

ok Adobe
Mew Composition... oo

Composition Settings...
Set Poster Time
Trim Comp to Work Area

Add to Adobe Media Encoder Queue...

Preview
Save Frame As
Pre-render...

Open in Essential Graphics

Responsive Design — Time

Composition Flowchart

Composition Mini-Flowchart

VR

= m B

ntdown

Status Started Time Comment

WL ISR countdown  [TEEECHER
? Render Settings: ' Best Settin
* Output Module: v H264 - Match Render Setting \bps + — OutputTo: Vv No



Timer animation gif video conversion

5. In the left panel of the
timeline Select the
"Rendering" tab.

6. In the render tab set
"Output Module" to
"Lossless with Alpha",
Select the destination _
directory and file name in sl o5 | $
the "Output to:" field. il e el

AIFF 48kHz
Alpha Only
H.264 - Match Render Settings - 5 Mbps
H.264 - Match Render Settings - 40 Mbps

High Qualit
High Quality with Alpha

Lossless

< Render Queue =

Lossless with Alpha

Multi-Machine Sequence

Phaotoshop

TIFF Sequence with Alpha v B 38w &2
Custom...

Make Template...

Render Time

> Render Settings: ' Best Sefting: Log: Errors Only

25



Timer animation gif video conversion

7. Click on the "Lossless Compression (with Alpha)" string that you have
set to display the Advanced panel (Output Module Settings).

8. Set the following settings on the "Main Options" tab of the
Output Module Settings screen. Output Module Settings

Main Options

form (something takes) QuickTime

Post-rendering processing | nashi (Pyrus pyrifolia, esp. var. culta)

Video output Check.
channel RGB + Alpha
color depth Millions of colors+
color Synthetic channel (with mat)

Audio output turned off Select

9. Press the "Render" button.

Audio Output Off




® Atfter Effects® (Windows/Mac)

S ave Sti I I i ma g e of I a St f rame of vi d eo @ Using Adoble Adobe® Photoshop® (Windows/Mac)

® instax Biz™"app template used for final composite photo

1.

Select a frame from the transparent
background video created in

Adobe® Premiere® Pro, and then click on
the Timeline Select the final frame (the
frame you want to output a still image).

. In the source panel (upper left area of the

screen) Select the "Effects Control" tab,
On the "Ultra Keys" submenu, to the left of
the string Click on the "fx" symbol to
display the gleeback.

. Program panel (upper right area of the

screen) Click on the camera symbol icon
(= Export Frame).

. In the "Export Frame" dialog, select

"Format". Select "PNG," choose a
destination, and click "OK.

!

Still images are saved in PNG.

Clicking this icon hides the Ultra key effect.

Still image of selected frame can be saved by pressing the camera icon.
27



Transparent background

1. Open the output still image from the
final frame of the video in
Adobe® Photoshop®.

2. Clicking on a subject with the Object
Selection Tool selects the person
part.

Object Selection
Tool" "Object Tool

Click on the person part

3. From the "Selection" menu
Select "Invert Selection" and
press the Delete key. Erase
the background area.

If you invert and erase the selection,
the background color (green
background) will be erased.

4. From the File menu "Export"

Select "Quick Export as
PNG" to save a PNG image
with a transparent
background.

Quick Export to
Overwrite and Save

Search Adobo Seock...
Search Adobae Exatoss Temoiates. Export Preforances.

Place Embedded. . =
Fiace Linked. Save for Web [Legacy)... Xons

Acamate >

Seripts

Import >

Import from @hane of ad 3| Liyers to Files..

Color Lookup Tables.

Fie Info...

Varsion His
ik Paths to ustrator

Print.. xp Rarades Vo

Print One Copy
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